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Introduction DISCOVERER
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Available at http://www.scilab.org
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Introduction: Integration with other tools and DISCOVERER
hardware

» Extend Scilab with other languages:
— Java, Python, Tcl Tk, Fortran or C, C++
« Use Scilab from different languages:

— Java, Python or C, C++

* Integration with other programs:

— Excel E

— Labview H
— OpenFoam TNy
. LabVIEW

OpenVFOAM
More information in https://wiki.scilab.org/Interoperability
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SCILAB DISCOVERER

B scilab 6.0.2 Console - ] X
File Edit Control Applications 7 Celestlab

ZEXBEE| Y S 2 =X &

Filz Broveser ?AX Wariahle Brovwser ?AX
JocumentsiMy Pictures}, ~ | 4 Name Value Type Visibility
~ ] |ans | x1 Boolean| local
Name Startuy ation:
p execution:
E;IMY Pictures loading initial environment
Mingw Compiler support for Scilab
Load macros
Load help
~ Command History ? A X
Start Celestlab => Version 3.3.1 R T[T T T T T E T T T TV STy IO Irer
-a.title. text = Horizontal Wind ™ + tet(opt) + " - Alt ="+
--a,%_label.text = "Geodetic longitude™;
Start CelestlabX --a.y_label. text = "Geodetic latitude™;
Load macros ~f.immediate_drawing="on";
Load gateways visible="on";
Load configuration Dt:’-‘ZFD
- = scf():
Load Java packages . visible;"on','
Load STELRA => Version 3.2 (embedded wersion) -f.immediate_drawing="off";
Load help ~nbeol = 128;
--cmap = rainbowcolormap(nbcol); W
< >
= Mewes feed ? A
&« Feedbacks on Scilab Conference 2019 B
-
.
- -
-
.. .
S C . l b.' Jawee
h1d in Germany
[[] Case sensitive [ | Regular exp... v
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Scilab: basic information DISCOVERER

Basic data element: Matrix

— everything is a matrix. All real, complex, Boolean, integer, string, and
polynomial variables are matrices.

Variables names case sensitive and only 24 first characters are considered

Protected variables: %i, %pi, etc.

High-level interpreted language with variables, flow, functions, primitives.

High-level functions for 2-D and 3-D data visualization
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Scilab: Useful commands
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DISCOVERER

B Help Browser

* Help command

«»

File Tools ?

--> help <name_of _command>
--> apropos(keyword)

« Workspace commands:

Ba
--> help =

- Differental cakcubs, Integrats
@ BementaryFunctons
5 Linear Algebra
- Interpolaton
- Control Systems - CACSD
% Polynomiais
B Signal Processing
FFTW

@ Specal Functans
G- | ARnoldi PACKage (ARPACK bi
@ Stabstics

- Sparse Matrix

G UMFPACK Interface (sparse)
5 Optimzation and Simulation

@ Genetc Algorithms

- Optimization: Annesing

- XML Management

- HDFS

- Fies : Input/Output functions
i3 Input/Output functions

@ Graphics

--> clc: clear screen e

--> what: show all the primitives

@ Stings
v Sound file handina
<

Scilab Homepage | Online Help | Wiki | Bug Tracker | Forge | Mailing Lists Archives | ATOMS | File Exchange

Scilab help >> Homepage

Welcome to Scilab 6.0.2

Scilab 6.0 s a major new release of Scila, the open source platiorm for numerical computation
Here is a tour of the changes between Scilab 6.0.0,6.0.18602

Feature Improvements

The console File == Open a file” menu now allows 1o open *xcos *2c0s
files were opened in Scinotes and could freeze it

*.50g or lib files with the proper Scilab component, and other files with the proper OS application. All

“ged” and “lem” of infegers now always return a positive result
“caf” has been rewniften. It is now fast and can process heavy arrays athigh dimensions
Wamings from plot3d1” called without an option were removed

“whereis® has been upgraded

registered in several libraries, “whereis* now retums all of them instead of only the last loaded one.
ed macros, “script™ is now retumed instead of "

“mgetl” speed has been improved for fles with a lot of lines

“ndgrid(x)” now accepts only one input “x", with by default "y=x"

--> who/whos: show all the variables (with -name show variables starting with

<>)

--> clear: delete all non protected variables
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Scilab: Create functions DISCOVERER

e Format:

= testfunct.sci (C:\Users\digg\Documents\testfunct.sci) - SciNo
function <lhs_arguments>=<function_name><rhs_arguments> File Edit Format Options Window Execute ?

CEEE S e d00 2%
Endfunction ‘test'ﬁ.mct.sd X
1|function y=testfunct (x)
» Create the function with the editor 3|endfunction
4
— Save as *.sci file with the name of the

function
--> exec testfunct.sci

* Load the function in the command line

—=> function y=testfunct (x)

: . o geoex
— exec filename.sci - endfunceion
—=> testfunct (2)

» Genlib to build library from functions (sci 4.

files) in given directory
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Scripting DISCOVERER

. __;," testscript.sce (C\Users\digg\Documents\testscript.sce) - SciNotes
 For long code scripts can be used: File Edit Format Options Window Execute ?

. . . B =1 = LIAEIE AP REIC IR S 2T
— Files with extension *.sce

testscript.sce |3

— Load: exec (‘filename.sce’) o
3| XY
— Can include definition of functions '
 Edit with the editor (applications/SciNotes):
_ // for Comments --> exec('C:\Users\digg\Documents\testscript.sce"')
— F5 to evaluate the script B

*
>
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L oad/save data DISCOVERER

Variables (environment) *sod
 Save and load commands

 Menu File/Save environment or Load environment

Graphics *.scg

» Any graphic figure can be saved:
— save() through its identifier as a variable
— Xsave()
— With figure's menu File /Save

 Load file *.scg: load(..) or xload()

» Several figures may be saved in the same file. Each restored figure gets a
new incremented #id, so usually not the original one.

This project has received funding from the European Union’s Horizon 2020 research and innovation programme under grant

agreement No 737183.




. L.
Scilab: Matlab DISCOVERER
* '‘Comparisons are odious*

o https://wiki.scilab.org/MatlabToScilab

« Conversor available

l Scilab 6.0.2 Console
File Edit Control Applications ? CelestLab

G B | s 5| (& ScNotes ®
File Browser
&2 Xcos
&) | ysers\digg
Matlab to Scilab translator
Name p execution:
=) Documents &= Module manager - ATOMS |ing initial environment
..
E 2;::@ Variable Browser Compiler support for Scilab
. Load macros
- {55 My Music Command History
+-{E8) My Pictures Load help
+-{i5) My Videos File Browser
{55 Updaters Sterc Celestlab => Version 3.3.1
J Abstract_ScilabConference_2019.pdf
{1] presentation1.pptx Start CelestlLabX

Load macros

Load gateways

Load configuration

Load Java packages

Load STELA => Version 3.2 (embedded wversion)
Load help

This project has received funding from the European Union’s Horizon 2020 research and innovation programme under grant

agreement No 737183.



https://wiki.scilab.org/MatlabToScilab
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Scilab: ATOMS

B scilab 6.0.2 Console
File Edit Control Applications ? Celestlab
ZEXCO|B EIR B X ®@

File Browser 2 A X Scilsb 6.0.2 Console

....?.
DISCOVERER

2 A X “arigble Browser ? A X

Iy MpII=l SWPPULL LUL TIaw

\digg\Documentsipatal | Load macros
Name -~ Load help

|ES Data
L

Start Celestlab => Version 3.3.1

& Mame Value Type Visibility

\:H |ans ‘ 0] Duublel local

@ Main categories - ATOMS

File ?

All modules MinGw toolbox 0.10.5

Bioinformatics Dynamic link with MinGW for Scilab on Windows

Contributed Scilab builds SCIHOME|atoms k64 |mingw|0.10.5

Data Analysis R

Data Handling = CNES Space Mechanics Toolbox for Mission Analysis

Documentation SCIHOME]atoms|x64 | celestbb|3.3.1

[&5 bomain-Specific

Edul;n:ionD CelestLabX 3.3.1 . . .
CNES Space Mechanics Toolbox for Mission Analysis (extension)

GUI : SCIHOME|atoms|x64|celestbx]3.3.1

] Graphics

Graphs

Image Processing

Instruments Control

Linear algebra

Manuals

Modeling

Number theory

Mumerical Maths

Optimization

|5 Parallel Computing

[] case seng Physics

Real-Time

|[E5 Scilab development

Signal Processing

Technical

Windows Tools

Xcos

?AX
w older (2)vieotoolbox e

atzgfftﬂp w folder (2)\vieotaolboxe
w folder {2)\vieotoolboxe

w folder (2)\vieotoolboxe

w folder (2)\vieotoolbox'e

w folder (2)\vieotoolboxe

w folder (2)\vieotoolboxe

w folder (2)\wvieotoolboxe

w folder {2)\vieotoolboxe

Loaded
at startup

Loaded
at startup

>

>

A x
ference 2015 B

A

ERENCE

y
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CelestLab/CelestLabX DISCOVERER

« Atoms/Domain-specific/Celestlab

= Domain-Specific - ATOMS - O X
3
File 7
Main categories CelestLab
~

CelestLabX Version

3.3.1

Author(s)

CNES

Description

Celestlab - CNES Space Mechanics Toolbox for Scilab
Version 3.3.1

Celestlab is a Scileb toolbox for Space Flight Dynamics.

It has been developed by CNES (Centre Mational d'Etudes Spatiales -
French Space Agency) for mission analysis purposes.

Celestlab can be used for trajectory analysis and orbit

design for various types of space missions.

It allows engineers to perform tasks such as: orbit propagation, attitude
computation, elementary manoeuvre computation, change of coordinate systems,

Celestlab comes with an extension module called CelestLabX.

The features in Celestlab that require CelestLabX to be installed are

related to:

- STELA: CNES orbit long-term propagation software

- Two Line Elements

- MSIS2000 atmospheric model v

Autoload Install Remaove Back
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XCOS DISCOVERER

File Edit Control Applications 7 Celestlab

E o - L
ZEXCOv E BB« e
File Browser 2 7 X Scilab 50.2 Console 2 n X “ariable Browser ?2AX
rrrIrgw MpIIcI SGUPPOLC IUT Trow
\digg\Documents\Datal, -~ * Load macros Q MName Value Type Visibility
~ 1 ans 0 Double; local
Name Load help ma [ | |
|5 Data
e Start CelestLab => Version 3.3.1
Start CelestLabX
Load macros
Load gateways
Load configuration Commaned History: ? A X
| Load Java nackages xcos( T XE ,,
5| Palette browser - Xcas — m} . ersl B Kzlman (C:\Program Files\scila

Palettes View File Edit View Simulation Format Tools ?

- @ @ = S = P—
Ee»iaa Q CEREm R e ar0acse0
Halman (C:\Program Filesiscilab-6 .0 2modulesixcosdemos Halinan. zoos) - Xoos 2

Palettes ~
- Recently Used Blocks

h 4 A 4 A
Continuous ti te é r‘ , -
DE:D;;EE;E?E systems e .‘ = - Kalman Filter
> > Pt

Discrete time systems

&

AFFICH_m R
Lookup Tables - BARXY CEVENTSCOPE CANIMXY o0 _D[;T y—™
Event handling * -'
Mathematical Operations estimated "x”
Matrix
Electrical -
Integer > Mat. 30 42 » 2 emor 4’{
Port & Subsystem =
Zero crossing detection CANIMXY3D CFSCOPE CLKOUTV_f CMAT3D bsa
Signal Routing ko
Signal Processing A 4 A 4 v
Implicit - b‘ J b — Random
Annotations - - - | generator
Sinks Mat. View > My
@ Sources CMATVIEW CM5COPE C5COPE CSCOPXY - DEMUX
# Thermo-Hydraulics
- # Demonstrations Blocks
- # User-Defined Functions
HALT < >
EMNALK ENM_r HAIT f v
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Xcos: Palette DISCOVERER

SN

- Standard Palettes and Blocks @ @

— Signal processing and signal routing } { } =5
1 Curve Counter From worksoace b
— Thermo-hydraulic blocks owrtamy O
— Mathematical operations, matrix, integer M My o (w
GENSIN_f GENSQR_f INIMPL_f IN_f

— Discrete and continuous system blocks

— Electrical FEER Lo
— User defined blocks e '- J-‘ ::C»O;
— Annotations: text, LaTeX/MathML 7= [eno u M
— Lookup tables oo mewx mbe s
— Event handling O'T@ @ :

UTIMPL <1 B TRASH_f

— Sinks and sources

| Write AUt ) Wiriteto
Idevfaudio € binary file

— Port and subsystem WRITEALS  VRITECS
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Model building and edition

 Blocks selection from existing palettes (drag and drop)

» Define inputs and connect blocks trough lines

....'?.
DISCOVERER

» Superblocks management (Sub-diagram embedded in a single superblock
for model reuse and simplification)

 All Scilab data types available for signal definition

>

>

P

Aftitucle

Latitucle

Longitude

ear

Day of year

Sec (UT)

AP 3h

o

Mericional wind

ﬂ?

Hiv12

Zonal wind

) J]
-144.0 ¥
o| To warkspace
| meridional [1]
&
56.7
v
o | To workspace

" zonal [1]

This project has received funding from the European Union’s Horizon 2020 research and innovation programme under grant

agreement No 737183.




Model customization DISCOVERER

» Simulation parameters definition (solver)

File Edit View Simulation Format Tools ? B set Parameters X
R 7 Final tion ti
|_| I—‘G I—'- | E " Setup ! inal integration time 1.0E05
i Real time scaling 0.0E00
Execution tr3 Debug
— Integrator absolute tolerance 1.0E-06
Set Context Integrator relative tolerance 1.0E-06
Compile Tolerance on time 1.0E-10
Modelica initialize Max integration time interval 1.00001E05
> Start Solver kind RK45 - Runge-Kutta 4(5) v
Maximum step size (0 means no limit) | o,0E00
; S
atitu¢ @  Stop SetContext
—J |
[Il Cancel Default

- Signals and blocks parameters adaptation =8 SocPamess. s
5 co cone
% Delete Delete

['y Selection to superblock
Format >
Details

@ Block Hel Ctrl+H
p
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Example: AntiwindUp PID controller DISCOVERER

PID controller

command K

plant I

kA
{l
= 9

output DAC limit To workspace

ry1 [4000]

To workspace
ul [4000]

PID controller with
back calculation
anti-windup scheme J\.._&Kp
-| k;_:__::::’lr—

plant
Ki output DAC limit

windup
compensation

Source: https://www.scilab.org/pid-anti-windup-schemes (Dew Toochinda, Scilab Ninja)
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Example: AntiwindUp PID controller DISCOVERER

2 000 —
1000 - e

00 o

-500 -

-1 000 - —

-1 500 +

-2 000 L B B e e L
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Code generation

Create Superblock

Block Parameters...

Cut

Copy
Delete

', Selection to superblock
Format
Details

® BlockHelp

T

frvwant

= as

Hal MUX
Ctrl+B B
Ctri+X
Ctrl+C .
Delete

|Selection to superblockl

Ctrl+H

....'?.
DISCOVERER

Generate code from superblock

" . |
r—i 1
| % Block Parameters... Ctrl+B
B b Cut Ctrl+X
[ Copy Ctrl+C
% Delete Delete
o= Y Selection to superblock
Format »
Details
® BlockHelp Ctrl+H
Code generation

Superblock mask

[Code aeneration|
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Xcos: Custom blocks DISCOVERER

» External code (C, C++, Fortran)
« Xcos models (generate code)

e Scilab code
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Xcos: Custom blocks DISCOVERER
* Install MinGw and its toolbox to be able to compile code (C/C++, Fortran)

o Atoms/Windows Tools/MinGw toolbox

&= Windows Tools - ATOMS - O X
File 7
Main categories MinGw toolbox
Author(s) ~
= scetoexe Allan CORNET
Is link
= s in Description

MinGW Compiler support for Scilab 6.0.0 and more on Windows

You need to install MinGW package distributed by Equation Solution first and
then you must install this interface module between MinGw and Scilab.

with Scilab 32 bits:

with Scilab 64 bits:

(* x64) http://atoms.scdlab.org/toolboxes/mingw/0.10.0/fles/acc-6.2.0-64.exe

See also
= http://atoms.scilab.org/teolboxes/mingw/0.10.5
« http://forge.scilab.ora/index.nhp/p/MinGW-toolbox/

Release date
2017-03-02

- ~-> haveacompiler
Download size 2

127 KB
Autoload Install Remove

ans =

T
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Xcos: Custom Toolbox DISCOVERER

e OSkeleton structure (contribs in Scilab source code):
e = Etc
ng = Help
o = |Images
B = Macros: Block definition and Scilab code,
: crengeos st = Src: Source code.
o FESCR'::GN = Builder.sce: compilation script.
: ortenes = Loader.sce: load toolbox.
L unloader.sce
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Xcos: Custom Toolbox

Declination | R
Altitucle Inclination
Horizontal ™
Latitude North
»
East
Longitude
: - Down >
(@) Total
Year \\ »
IGRF12/ WMM15 RECYAD
secvarl >
Months
secvarH
»
Day of month secvarNorth
secvarEast »
Model secvarDown N

He density |
Altitucle
O density
Latituce
N2 density
Longitude ;
02 density
Year 5 Ar density
N
Day of year = Total mass den.
N |
Seconds ok i) H density
N density
F10.7 av.
Anomalous O density
F10.7
Exospheric temp.
AP (daily)

secvarTotal

S

Temp. at att. |

/

DISCOVERER

N D
M Altitude Temperature
, P Altituce
Exospheric temp
M Latitude
Atomic H M Latitude
P Longitude
Helium Meridional wind
M Longitude
P Year Atomic O —
» Month Molecular N P Year —??
» Day oTmzo0iz  Molecular O HWAM14
M Day of year
Atomic N Zonal wind
M Hour
Density P Sec (UT)
» Minute
Dens. unc.
M AP 3h
b( Second Mean mol mass
N / "\._;
I p \
A »Q N »Q
> > >
M B B P im
MAGNETIC TORQUE GRAVITY TORQUE
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Links
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DISCOVERER

‘ Download
@ Tutorials
W Wik

8 Mail lists
6] Forum
Books

@ Control Eng.

https: //www.scilab.org /download /6.0.2

https: / /www.scilab.org /tutorials

https: / /wiki.scilab.org/

https: / /www.scilab.org /about /community /mailing-lists

https: / /scilab.in /forum

https: / /www.scilab.org /about /community /books

https: / /scilabdotninja.wordpress.com/scilab-control-

engineering-basics/
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Demo DISCOVERER

This project has received funding from the European Union’s Horizon 2020 research and innovation programme under grant
agreement No 737183.




®°.
DISCOVERER

System Modelling and Simulation with
SCILAB

David Gonzalez — Valentin Cafas
DEIMOS

Brussels, 28 November 2019

This project has received funding from the European Union’s Horizon 2020 research and innovation programme under grant

agreement No 737183.




